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BACK PADDOCK - ADVISER MANUAL - About Scenarios

COMPANY

1. Overview
Scenarios in our program are “drop in” crop, fertiliser and operations templates that include
information regularly used to expedite the planning process. Adviser Professional comes with
approximately 100 scenarios for different crops and products for your convenience, but also
provides you with the tools required to manipulate these or create brand new ones to your own
specifications. Creating and using these is particularly useful in situations where you regularly
recommend or utilise the same products or fertilisers associated with a crop variety on a large scale
— perhaps even across different clients. The purpose of this guide is to highlight certain hints and
tricks, and to familiarise with Scenarios and their use. If you’re new to Scenarios, try them out first in
the DemoFarm provided with your program.

2. Frequently Asked Questions

2.1 Can |l use someone else’s scenario file?
Absolutely. These files can be shared through the directory by emailing or transferring between
computers on a USB. As the program can store several “scenario files” this need not impact your
own.

2.2 Does the file have to be called something in particular to work?
No, as long as the file type stays “.scen” the program will be able to use this. Name these
appropriately to help you distinguish between multiple files.

2.3 Will my Master Database automatically update my Scenarios?
No, Scenarios are kept up to date manually by you as the user. There are tools available in the
program to simplify this process. For example, Find/Replace Data and Copy Data between Paddocks.

2.4 Dol need to use Scenarios?

Not at all, they are a tool designed to assist you in your program.

2.5 Where is my Scenario File located?
Scenarios are installed with your program, and are found at Documents\Back Paddock
Company\Adviser\Scenarios.

2.6 What happens if | accidentally delete my Scenario File?
We have our base scenario file available on our website at www.backpaddock.com.au by clicking on

Products > Adviser > Download Scenario File. Unfortunately, your modifications will not be present
in the newly downloaded version. To save some of these, you may be able to go back through your
client file and “Load Selected Paddock to Scenario”.
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2.7 Will my Scenarios sync through CornerPost to another user?
No, your Scenario file is a local file, not one shared on CornerPost. If you choose to share this with
another user, it can be emailed or saved to a USB for transferral. It should then be saved in the
correct location on the second users’ computer, and the Scenario file selected following instructions
in step 7 of this guide.

3. Familiarisation

=, . -
@ Q3 € » 2013 DemoFarm_Katy - Back Paddack Adviser Professional
Home Farm Rotations Analysis Rainfall Cash Flow Livestock Inventory Reports Mapping
@ Lﬁ (" Barley blend under sown Garlon=Triflur=Achieve ~ E View Selected Scenario % Copy Plan To Actuals
b add Scenari ock R Delete Selected Scenario | 4% Update Client From Master
Plan Copy Data Between Find/Replace  Master
Paddocks Data Database | 4 Load sk Update Area From Paddock Master

Plan / Actuals Data Scenario Manager Tools

The starting point for Scenario use in the program is in the Home tab. This is how we access and
allocate Scenarios, and also open Scenario Manager which opens the Scenarios as a separate client
file.

3.1 View Selected Scenarios
This enables the user to have a “sneak peak” at what is included in the current Scenario displayed in
the white bar. This will open a printable form highlighting crop, fertiliser, operations etc.

=1 Llose

Barley blend under sown Garlon+TriflurtAchieve

SEED:

Barley LI/S blend (Tilga malt) 30 katha 200 $/t Apply insecticic
Pasture mix [Clover / Pharlaris) 2kgtha 2000 4/t Apply insechicic

0.15 LA100kg 4395 %L
WL zinc chelate 113 4 LA 00kg 5L
FERTILISER:
MAP [Incitec Pivot Ltd) 100 kgsha BE0 3t
CHEMICALS:
[ wiater rate: 30 L/Ha

Garlon B00-some vol 012 L/Ha 27 L
E sterciderdtra B80-ow val 0.4L/Ha 928/
1L/MHa E.05 $/L

@06 % B/l

@03% B /L

Water rate: 50 L/Ha
1L/MHa E05 /L
1.5LHa 46 $/L
@03% B$/L

‘water 1ate: 50 LAHa

3.2 Delete Selected Scenarios
This deletes the file currently displayed in the white bar. A prompt will ask you to confirm this delete
before proceeding. Deleting a scenario here also deletes in your Scenario file.

3.3 Add Scenario to Selected Paddock
This allows the user to take the Scenario currently displayed in the white bar, and apply it to the
highlighted paddock in the program.

3.4 Load Selected Paddock to Scenario
This allows the user to create a template copy of any information stored in a paddock, for use as a
scenario. This is a great way to “tweak” a Scenario on the go, without going through Scenario
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Manager. Simply Add Scenario to your Paddock, adjust as required, and Load Paddock to Scenario

giving it a new name.

3.5 Scenario Manager
Now we’re pulling out the big guns. This enables the user to open the scenario file as a client file,
with the scenarios listed in the Navigation pane like paddocks, and the details listed in the program

as they are when you use a scenario.

4. Open Scenario Manager
The easiest way to open multiple scenarios for editing and updating purposes is through this tool.

« Q¢ ¢ » 2013 DemoFarm_Katy - Back Paddock Adviser Professional

Home Farm Rotations Analysis Rainfall Cash Flow Livestock Inventory Reports Mapping

@ ﬂ “ Barley blend under sown Garlon=Triflur+Achieve - E View Selected Scenario %Copy Plan To Actuals
| ‘ B
Add ock # Delete Selected Scenario 'ajUpdate Client From Master

een Find/Replace  Master
Data Database £ Update Area From Paddock Master

Plan / Actuals Data Scenario Manager D Tools

Plan Copy Da

1. Click oniconin red square above

Scenario Manager Setup

File
O ®
Use the Browse Button to Set the Current Scenario File oK
C:Users'katyl ADROIT Documents'Back Paddock
Company\Adviser\Scenarios'Scenarios. SCEN

2. Click Open Folder
3. Select required Scenario file (always extension .scen)
4. Click Open

Your Scenario file has now been opened in Adviser for modification.

4|Page




5. Customising Scenario File
If you are opening your Scenario File as a client file for the first time the first step may be to establish
which scenarios you may use, which you may discard, and which you may remove from view but not
delete.

5.1 Edit Scenario Lists
With your scenario file open, you are now able to edit names, exclusions and deletions in the same
manner as manipulating your Paddock details in Adviser.

<~ [at € Scenarios Horticulture1
Home Farm Rotations Analysis Rainfall Cash Flow Livestock Inventory Reports Mapping
A v éll, ’ * :'Qﬂ ’x ¥| Quick Entry Mode @ E Home Farm E ﬁ\
= Restructure Paddocks - Edit Farms
Move Move Sort Add  Insert Delete Print CopyTo Rainfall Maps Machinery
Up Down MNew  Mew Clipboard Sites
Paddocks Export Multi-Farm View
Exclude | Paddock Mame Area [ha) Arable [ha] | Arable % | Soil Details Prad. Spstem [def.] |Motes [AllYears)

|1 Apples RU+5Select i} Broadacre

2 | Avocado sprayphos+carbary 5 Broadacre

3 | | Banana i} Broadacre

4 | Cane Fallow RU+5tarane+G 5 Broadacre

5 | | Cane Ratoon v'1 1Gramoxon i} Broadacre

B Ll Cane Ratoon vt 2 Gramoxor 5 Broadacre

1. Click Farm tab from your Scenario file

Take a moment to look over the buttons displayed at the top; Move, Sort, Add New, Insert New,
Delete. These will be used to manipulate your lists. The tick boxes shown below “Exclude” will also
be used to temporarily remove particular scenarios from sight in your Adviser scenario drop down
list.

Edit Names
1. Leftclick in the required “Paddock Name” bar
2. Type in new name as required
3. Click off to save

Delete Scenarios
1. Click on name of scenario you wish to permanently delete
2. Ensure black arrow is pointing at correct line number (far left)
3. Click Delete
4. Confirm “Delete Selected Paddock” by clicking Yes

Exclude Scenarios
1. Click in Paddock name bar of scenario to be excluded
2. Click in check box in Exclude column beside scenario selected

Add New Scenarios

Click Add New in Scenario Manager, new line will be created at end
Type in new Scenario Name

Click off to save

P wnNhe

Populate fields as required in Home tab
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5.2 Edit information in Scenario Manager
Assumed knowledge in this guide is that you are familiar with how to enter data for sowing, soil
health, sprays, operations and production. If you’re not 100% sure on this one have a look at the
DemoFarm provided in your program by clicking on File > Open > DemoFarm. This is the best place
to try new things without it affecting your data. Try dropping a new scenario in a paddock here first
to ensure it is correct before using in your Client File.

Sowing, Soil Health, Sprays, Operations, Production
Looking at the Home tab of Adviser, the scenario can be used to input information into the Sowing
field (or Management Zones) which include crop, variety, dates and pricings.

v T Scenarios Horticulture15072012 - Back Paddock Adviser Professiona
Home Farm Rotations Analysis Rainfall Cash Flow Livestack Inventory Reports Mapping
a;a> =L _ﬁ r“ Barley blend under sown Garlon=Triflur-Achieve - [S] View Selected Scenario g Copy Plan To Actuals
= \’ @ Add Scenario to Selected Paddock K Delete Selected Scenario 'ﬂr] Update Client From Master
Plan Copy Data Between Find/Replace Master
Paddocks Data  Database 4P Load Selected Paddock to Scenario s Update Area From Paddock Master
Plan / Actuals Data Scenario Manager ] Taols
Navigation ? Management Zone
(El\W = = ¥ | Blend/Undersow Dress |Irigation| Flags | & = -8 | 4|
& Scenarios Horticulture 15072012 {175 0 ha) -
< Apples RU+Select S
< Avocado sprayphos+carbary!
@ Banana il i
& Cane Fallow RU=Starane+Gramoxane Crop Type ariety Units |Stat Date [FinishDate | $/Unit | ha | Unitsha | Rowm) | Plantm] | Date[ Symbal |Footnote
< Cane Ratoon Yr 1GramoxonesDiuron+Arazine |RLCane 2nd Ratoon 0183 + Ratoon ! ! ! R | \ IRECETS| \
Cane Ratoon Yr 2 Gramoxone+Diuron-+
< Camots 55
< Ginger Spirflow+RU+S5
< Grapes Shiraz RU+Dithane+55
< Grapes Table RU+Dithane=55
< Grapes Wine RU+Dithane+55
@ Mango Zinc+RLU+Dimethoate
< Olives RU+55
< Onions RU+Dimethoate
< Orange Sweet RU
< Orange Sweet Leeton Soil Health
< Peaches RU + Select
& Pear Bl + Select Soil Health  Sprays  Operations § Summary  Diary Gross Margins  General  Water Use Efficiency  Rotation Analyzer  Spray Recommendations
< Pineapple S
< Plum RU+select eil=ey
< Potato Tubers RU+gesagard+bravo v b4 pg By # History Tests Elements | Copy Selected SoilMate Recommendations
< Fotatoes Fresh
< Potatoes Leeton RU+gesagard +bravo | Fetliser |Cost (57t) |Area [ kg or Wha|Timing |Date | Liquid | BD it/n?) | Symbol |Footnate
& Potatoes NW NSYY Rl+gesagardsbrava M Urea [Incitec Pivot Ltd) - | 500 E] | 100 [Before outofhand [15/07/2006 | [0 | 07 | |

Working our way down the page; Soil Health, Sprays, Operations and Production are all included as
Scenario fields.

Enter information into these fields following standard procedures. If you are unfamiliar with the
program, hover over each of the buttons available under each tab for a small description. One big
play-toy here might be to “Copy Data between Paddocks”. Use this to bulk-transfer data to other
similar scenarios, for fine tuning.

Updating costs, pricing and rates

In addition to updating the Master Database, scenarios need to be kept updated to maximise ease of
use in the program, and keep your data as accurate as possible. “Find/Replace Data” will be very
useful here for updating chemicals, prices or rates of application. It is recommended that this is
updated whenever there are price / rate changes available. This will be much easier than saving it all
up to do in one big swoop!
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6. Close Scenario Manager
Although information is saved “as you go”, Scenario Manager should be closed when modification
has been completed in order to use your data throughout the program.

1. Click File
2. Click Close

7. Set Scenario File

The current Scenario File is set in the Scenario Manager tool.

“ Q¥ 4 » 2013 DemoFarm_Katy - Back Paddock Adviser Professional
Home Farm Rotations Analysis Rainfall Cash Flow Livestock Inventory Reports Mapping
a;3> ﬂ "“ Barley blend under sown Garlon=Triflur=Achieve - | [ View Selected Scenario  Bfg Copy Plan To Actuals
\ Add oC # Delete Selected Scenario 'ﬂjUpdate Client From Master
oy Update Area From Paddock Master

Plan Cop een Find/Replace Master
Data Database

Plan / Actuals Data Scenario Manager Tools

1. Click Scenario Manager icon as above

Scenario Manager Setup
File
DEed ®

Use the Browse Button to Set the Current Scenario File oK

C:Users'katyl ADROIT' Documents'Back Paddock =

Company\Adviser'\Scenarios'Scenarios. SCEN

Click Browse

Click to highlight required Scenario File (always extension .scen)
Click Open

Click OK

vk wN

Your Scenario file has now been selected as current. You may need to close and re-open Adviser if
this does not immediately take effect.

Thanks for joining me in understanding Scenarios!

By completing these set-up steps, you will save yourself a lot of time and complication down the
track. Take a rest and come back to the next part of our Manual. If you think we’ve missed anything,
don’t hesitate to contact us by email and we will do our best to incorporate this or at the very least
answer your enquiry!
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8. Help please!
We at Back Paddock understand that everyone is different and learns in different ways. To facilitate
this and make our products more accessible for everyone, we have a plethora of different ways and
means of obtaining assistance in any situation.

8.1 Talking to Real People
That's fine by us! We have a HelpDesk service that operates Monday to Friday 7:30am — 5pm on free
call 1800 557 166 and we are always happy to take your call.

8.2 See things Visually
Private webinar sessions can be arranged if you say please very nicely, and send an email through to
BPCSupport@backpaddock.com.au Alternately, there are a few videos on various processes

available online at http://www.backpaddock.com.au/help-desk/ This gets updated frequently, so if

you have a question about something that’s not up there, let us know and we may just create one
inspired by your request!

8.3 Notes to look at it in my own time
Not a problem! As well as this user manual, we have a heap of Help Sheets available online to point
you in the right direction, get you started, and save you from any sticky situations you might find
yourself in. Visit: http://www.backpaddock.com.au/help-desk/ for the full list organised by program.

8.4 Phones are down, need help!
Have you seen met our Online Consultant? She’s friendly, patient, knowledgeable and about three
clicks away! Reach her at http://www.backpaddock.com.au/help-desk/ by clicking on the Site

Consultant button.

8.5 Non-urgent brainwave in the middle of the night?
How about an email? We've usually responded by the end of the next business day, and this gives
you a chance to send us your thoughts or questions at any hour of the day or night! Give us a yell at
BPCSupport@backpaddock.com.au

Good luck, and have fun!

Back Paddock Team.

Ph: 1800 755 166
E: BPCSupport@backpaddock.com.au
W: www.backpaddock.com.au
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